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1.​ Abbreviations 
Abbreviations Definition 

AP Access Point 

CB Circuit Breaker 

CHAP Challenge-Handshake Authentication Protocol 

CL_F CL interface unit with Fiber Optic Network communication 

CL_T CL interface unit with Telecom Mobile Network communication 

CL_W CL interface unit with WiFi communication 

DCG Data Concentrator Gateway 

DL Downlink 

DNP3 Distributed Network Protocol 3 

EMC Electromagnetic compatibility 

FDU Fiber Optic Distribution Unit 

GW Gateway 

IEC International Electrotechnical Commission 

IMSI International Mobile Subscriber Identity 

IT Information Technology (in "IT rack") 

LBS Load Break Switch 

LED Light Emitting Diode 

LTE Long Term Evolution 

MCB Molded Circuit Breaker 

MCC Mobile Country Code 

MNC Mobile Network Code 

MTS Manual Transfer Switch 

OS Operating System 

PAP Password Authentication Protocol 

PLMN Public Land Mobile Network 

PSU Power Supply Unit 

RJ12 Registered Jack 12 (connector type) 

RJ45 Registered Jack 45 (connector type) 

RS485 Serial Modbus communication port 

SPD Surge Protection Device 

SPF Small Form-Factor Pluggable Fiber Optic 
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Abbreviations Definition 

SSID Service Set Identifier 

TW Thermal Watch 

TWR Thermal Watch Receiver 

TWR-DIN Thermal Watch Receiver - DIN mounted module 

TWR-IR Thermal Watch Receiver - Infrared Receiver 

TWS Thermal Watch Sensor 

UL Uplink 

UPC Ultra Physical Contact (fiber optic connector polish) 

VAC Volts Alternating Current 

VDC Volts Direct Current 

WebUI Web User Interface 

WIFI Wireless Fidelity 

 
 

2.​ General safety instructions 
The instructions in this manual are not intended as a substitute for proper 
training or adequate experience in the safe operation of the equipment 
described. 
 
Only competent technicians who are familiar with this equipment should 

install, operate, and service it.  
 
A competent technician has these qualifications: 
  
• Is thoroughly familiar with these instructions.  
 
• Is trained in industry-accepted high and low-voltage safe operating practices 
and procedures.  
 
• Is trained and authorized to energize, de-energize, clear, and ground power 
distribution equipment. 
 
• Is trained in the care and use of protective equipment such as arc flash 
clothing, safety glasses, face shield, hard hat, rubber gloves, clampstick, 
hotstick, etc. 
 
This manual may contain four types of hazard statements: 
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DANGER  
Indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury. 

WARNING  
Indicates a potentially hazardous situation which, if not 
avoided, could result in death or serious injury. 
 
 

CAUTION  
Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury. 
 
Or indicates a potentially hazardous situation which, if not 
avoided, may result in equipment damage only. 
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3.​ Introduction 
The Thermal Watch Sensor (TWS) are designed for monitoring low and high-voltage 
electrical connections, whether on a circuit breaker, a bus bar installed in an electrical 
switchboard or switchgears. It is available with two maximum temperature configurations and 
a 16mm form factor allowing the sensor to be installed on terminals as small as MCBs. 
The device sends periodically and on alarm threshold the following informations: 

-​ Temperature 
-​ Identification number 
-​ Battery level 
-​ Mode. 

The device is powered by a high grade battery that lasts up to 10 years with 1h 
measurement cycles. 
For commissioning and testing purposes the device can be operated with a magnet. 
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4.​ TW range components & features 
 
 

Thermal Watch 
Sensor 
(TWS) 

Thermal Watch 
Receiver - Infrared 

Receiver 
(TWR-IR) 

Thermal Watch 
Receiver - DIN 

mounted module 
(TWR-DIN) 

Data Concentrator 
Gateway 

(DCG) 

Measures the 
temperature a point 
where it is installed 

Communicates with 
the TWS through 

infrared, collects data 
of multiple TWS in the 

range 

Connected to the 
TWR-IR through a 

RJ12 cable, the 
TWR-DIN collects and 

stores data. 

A data concentrator 
that collects and 
render data from 
TWR-DIN 

 

 
 

 

 
 
 

 

 

 

Exist in 2 form factors 
and 2 temperature 

range. Up to 85*C and 
up to 115*C. 

 Exists in 3 form 
factors, with 1, 5 or 13 

connections to 
TWR-IR 
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5.​ TWR-DIN family 
 

 TWR-DIN1 TWR-DIN5 TWR-DIN13 

Application Isolated panels MV circuit breakers 
Form 1, 2  panels 

Large Form 3, 4 panels & 
MCC 

Width 3x DIN MODULES 
53mm 

4x DIN MODULES 
71mm 

6x DIN MODULES 105mm 

RJ45 terminals 
8p8c 
 
for 
RS485 & 12..24VDC 

2x IN / OUT 2x IN / OUT 2x IN / OUT 

 

   

RJ12 terminals 
6p6c  
 
for 
TWR-IR port 

1x 5x 13x 

NO/NC (3 terminals) 1x 

Power LED 1x 

Port ALARM LEDs 1x 5x 13x 

General State LED 1x 
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6.​ Technical characteristics 
6.1.​ Technical characteristics TWR-DIN 

 

Description Details/Requirements 

IDENTIFICATION  

Model Name TWR-DIN 
Part number 110.1_ _ . _ _ _ 
Product Full Description Thermal Watch DIN mounted receiver 
POWER SUPPLY / INPUT  

Supply voltage 12 - 24 VDC 
Maximum power consumption DIN1 : 0.5W 

DIN5 : 1W 

DIN13 : 2W 

Wiring Through RJ45 CAT6 see pin out in relevant paragraph 
Service life 10 years 

GROUNDING  

Wiring No required 
SERIAL RS485 MODBUS  

Type Through RJ45 CAT6 see pin out in relevant paragraph 
Maximum distance 200 meters 
Baud rate up to 115 000 
Data Bits / Stop bits / Partity 8 / 1 / none 
Maximum @12VDC :  DIN1 = 30pcs in series / DIN5 = 15pcs / DIN13 = 7pcs 

@24VDC :  DIN1 = 60pcs in series / DIN5 = 30pcs / DIN13 = 14pcs 

MECHANICAL  

DIN Frame # 3 Modukes 4 Modukes 6 Modukes 
Dimensions WIDTH mm 53 

HEIGHT mm 102 

DEPTH mm 63 

WIDTH mm 71 

HEIGHT mm 102 

DEPTH mm 63 

WIDTH mm 105 

HEIGHT mm 102 

DEPTH mm 63 
Net weight 104g 152g 242g 
IP rating IP30 
Mounting type Clip on DIN Rail 35mm 
Labels includes Hardware version number, serial number, manufacturing batch 
Enclosure material Polycarbonate/ABS 
ENVIRONMENT  

Ambient temperature -20 to +70*C 
Storage temperature -20 to +70*C 
Electromagnetic compatibility (EMC)  

Electrostatic discharge EN 61000-4-2:2009     |      Performance B 

Power frequency magnetic fields EN 61000-4-8:2010     |       Performance A 

Fast transients EN 61000-4-4:2012     |       Performance B 
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Injected currents (radio-frequency common mode) EN 61000-4-6:2014     |      Performance A 

Surges EN 61000-4-5:2014 + AMD1:2027     |      Performance B 

Emission IEC 61000-6-4:2018 | Class A 

 

6.2.​ Technical characteristics TWR-IR 
 

Description Details/Requirements 

IDENTIFICATION  

Model Name TWR-IR 
Part number 110.1_ _ . _ _ _ 
Product Full Description Thermal Watch IR Receiver 
POWER SUPPLY / INPUT  

Supply voltage 12VDC supplied through RJ12 and TWR-DIN 
Frequency 50Hz or 60Hz 
Wiring Through RJ12 
Service life 10 years 

GROUNDING  

Wiring Not required 
COMMUNICATION  

Type Proprietary 
Maximum distance 20 meters, more consult us 
Cable RJ12 6p6p 
Cable power frequency withstand voltage > 1000VAC 
MECHANICAL  

Dimensions WIDTH mm 81 

HEIGHT mm 35 

DEPTH mm 51 
Net weight 69g 
IP rating IP30 
Mounting type Nuts and bolts 
Labels includes Hardware version number, serial number, manufacturing batch 
Enclosure material Polycarbonate 

ENVIRONMENT  

Ambient temperature -20 to +70*C 
Storage temperature -20 to +70*C 
Electromagnetic compatibility (EMC)  

Electrostatic discharge EN 61000-4-2:2009     |      Performance B 

Power frequency magnetic fields EN 61000-4-8:2010     |       Performance A 
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Fast transients EN 61000-4-4:2012     |       Performance B 

Injected currents (radio-frequency common mode) EN 61000-4-6:2014     |      Performance A 

Surges EN 61000-4-5:2014 + AMD1:2027     |      Performance B 

Emission IEC 61000-6-4:2018 | Class A 

 

6.3.​ Technical characteristics TWS 
 

 
Description Details/Requirements 

IDENTIFICATION  

Model Name TWS1 
Part number 109._ _ _ . _ _ _ 
Product Full Description Thermal Watch Sensor 
POWER SUPPLY / INPUT  

Supply voltage 12VDC supplied through RJ12 and TWR-DIN 
  

  

  

  

  

  

  

  

  

  

  

  

 
 
REFERENCE 109.xxx.xxxx 

 Characteristics 

CONTINUOUS VOLTAGE WiTHSTAND 15kV 

COMMUNICATION 

TRANSMISSION PERIOD from 60s to 7200s 

MAX DISTANCE line-of-sight / direct 6m 

MAX DISTANCE diffuse / indirect 3m 

POWER EMISSION dBm 

COMMUNICATION FREQUENCY 38kHZ 

COMMUNICATION PROTOCOL Proprietary 

COMMUNICATION WAVELENGTH 940nm (nanometer) 
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SPECTRAL HALF WIDTH 50nm (nanometer) 

VIEWING ANGLE 12 degrees 

MECHANICAL CHARACTERISTICS 

WEIGHT 3grs 

DIMENSIONS 29 x 16 x 13.5 mm 

PLASTIC CHARACTERISTICS UL 94 H-B 

MOUNTING SUPPORT 
DIRECTLY ON ACTIVE PART VIA 

Zap Strap/Cable Tie 

MEASUREMENT  
TEMPERATURE ACCURACY with dT/dt < 1*C/min @40*C +/-5*C 

TEMPERATURE MEASUREMENT RANGE 0*C to +120*C 

ENVIRONMENT 

OPERATION AMBIENT AIR TEMPERATURE -20*C to +125*C 

STORAGE AIR TEMPERATURE -20*C to +70*C 

RELATIVE HUMIDITY 10%....100% 

IP IEC 60529 IP68 

OPERATING ALTITUDE 0.....2000m 
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7.​ Quickstart  
7.1.​ Putting things together  
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Note : If the magnet is held in position for more than one short blink, 28-bit 
transmissions will occur for successive short blinks. Long blinks commence after five 
short blinks. Be sure to remove the magnet before long blinks commence. 
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7.2.​ Installation of USB to RS485 Driver 

Follow these steps to install the driver: 
1.​ Connect the module to the host PC, check Device Manager, if the device is listed 

with the yellow exclamation mark, it means that the driver was not installed.

 

 

2.​ Download the driver form VCP Drivers, unzip, and install it. 
3.​ After installing, you can find that the mark disappeared and a COM device is 

listed.

 

7.3.​ Installation of TW configuration software 
Follow these steps to install the software: 

1.​ Install an additional Microsoft Windows component: .NET Runtime 8.0.x 
2.​ Download a zip-file with TW software from the provided link. 
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3.​ Unzip program files to the desired location. 
4.​ Launch the program file:​

./<installation location>/Paralec.Desktop.TW.exe 
 

 

7.4.​ Create (open) project 
All the configuration parameters and fetched history data can be saved into the 

project file. So, it makes possible offline access to the downloaded data offline later. Each 
installed TWR-DIN should be associated with a related project file.  
 

The project folder contains 2 files: 
●​ .twr10 - project file that includes information about TWR-DIN configuration 
●​ .db - database file that stores all data downloaded from the device 

 
The project name should relate to the installation of TWR-DIN. For example; 

<Location>-<Section Code>-<Feeder Code> 
 

Open or create a project related to the certain TWR-DIN device: 
1.​ Project -> Create -> Enter name and location of folder for TW projects 
2.​ or Project -> Open -> Open TW project (.twr10)

​
​
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7.5.​ Set connection parameters 

Follow these steps to set connection parameters: 
 

1.​ Open Connection Settings menu: Connection -> Settings 

 
 

2.​ Set Serial Port parameters (normally Port name and Device Address should 
only be adjusted). 

 
 

The following parameters can be set: 

Parameter Name Note 

Protocol ●​ RTU 
●​ RTU over TCP (not implemented) 
●​ TCP (not implemented) 

Port Write the Serial Port name that is used for communication 

Baudrate By default TWR-DIN uses 9600 b/s 

Data bits TWR-DIN supports only 8 data bits 

Stop bits TWR-DIN supports only 1 stop bits 

Parity Parity check 

Timeout Set at least 3000 ms to ensure the stable connection  

Device Address The Modbus Unit ID (address) of the device (1 by default) 
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7.6.​ Establish connection with the device 

Follow these steps: 
1.​ Check connection parameters (especially port name and the device address) 
2.​ Click “Connect” button 

 
 

3.​ Wait until the Connection Status Icon becomes clear green.  

 
 

4.​ If the device connected for the first time to the opened project the program 
asks to accept associating device Serial Number with the project database. 
Click “Yes” if this device should be associated with this project. It is made to 
prevent downloading the data from the device to the wrong project 
(database). 

 
5.​ Check the parameters values in the Diagnostic tab (Windows -> Diagnostics) 

or other live-views that have a green color. If the values are not fetched yet or 
there is a connection issue they will be gray. 
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7.7.​ Check device time 

To ensure the right timestamps of measurement  the device time has always been 
synchronized. 
 

To check the device time: 
1.​ Open Diagnostic tab: Window -> Diagnostic. 
2.​ Check the value of the parameter DS01“System Time”. It displays the current 

time of the device in UTC format.  

 
 
 

If the device time is not correct then it  should be synchronized manually: 
1.​ Open Commands tab: Windows -> Command 
2.​ Click “Execute” on the command EX01 "Synch time”

 
3.​ Check if the time is synchronized with the PC under the Diagnostic tab. 
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7.8.​ Set up main configuration parameters 

Ensure that device is configured properly according to the needs: 
1.​ Open Configuration tab: Windows -> Configuration. 
2.​ Set required parameters
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7.9.​ Set up binding to positions 

Follow these steps: 
1.​ Open Dashboard tab: Windows -> Sensor. 
2.​ Click on the gear icon to bind a sensor to this position.
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7.10.​ Upload configuration parameters to the device 

Ensure that device is configured properly according to the needs: 
 

1.​ Check the “Data Synchronization" indicator on the right side of the toolbar. If 
there is a difference between the configuration parameters between the 
device and project this indicator will be orange. If configuration is not fetched 
yet or connection is not established then this indicator will be gray.

 
 

2.​ Accept configuration parameters 
a.​ If you need parameters in the project to match the device configuration 

click “Apply from device” button (arrow up icon) 
b.​ If you need parameters in the device to match the project click “Upload to 

Device” button (arrow down icon) 
 

3.​ Make sure that the “Data Synchronization" indicator on the right side of the 
toolbar is green with a mark icon inside.

 
 

7.11.​ Download all records from the device 
If the software is connected to the device it automatically downloads all recorded 

data from the device. The progress is displayed on the right side of the toolbar. Make sure 
that all data is downloaded (100%) before analysing the measurements history. 

 

 
 

7.12.​ Disconnect from the device and save the project. 
1.​ Click on the "Connection" button again to disconnect from the device. 
2.​ Don’t forget to save the project if configuration parameters were changed. 
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8.​ Installation  
8.1.​ TWR-DIN Installation 

The TWR-DIN device is mounted on a standard 35 mm DIN rail. 

                 

 

8.2.​ TWR-IR Installation 
The TWR-IR device is mounted using an adjustable mounting bracket. The bracket 
allows the installation angle to be set to 90°,75°, 60°, 45°, or 30° to suit the 
application. 
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8.3.​ Safety rules 

 

DANGER  
Isolate and ground lines prior to installation 
 
De-energize parts 
 
Contact with hazardous voltage will cause death or severe 
personal injury. Follow all locally approved safety 
procedures when working around high and low-voltage lines 
and equipment.  

WARNING  
Wear personal protective equipment! 

CAUTION  
Check all fittings after installation 
 
Check the correct earth connection with a continuity tester! 
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8.4.​ Product Dimensions  

8.4.1.​ TWR-DIN1 Dimensions 

  
8.4.2.​ TWR-DIN5 Dimensions 

 

 
8.4.3.​ TWR-DIN13 Dimensions 
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8.4.4.​ TWR-IR Dimensions 

 

8.4.5.​ TWR-IR Rotation bracket dimensions 
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8.5.​ Mounting 

8.5.1.​ Materials Required for TWR-IR and Rotation Bracket 
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8.5.2.​ TWR-IR in panel with rotation bracket 

 
 
 
 
 
 
 
 
 

© Paralec Energy  |  TW |   Operating Manual  | TW_20251202_V1.0​ ​ page 30 / 44 



 

9.​ Connections   
9.1.​ TWR-DIN  - RJ45 connectors and Power Supply 

RJ45 specifications 

 

The device shall be supplied with a 12 to 24 VDC power supply, with a tolerance of ±1 volt. 

●​ Higher voltage may result in damage to the power input. 

 

9.2.​ TWR-DIN - Dry contact output connection   
When an output is required, the terminals below shall be used for the output dry contact. 
 

Pole Function (Dry Contact Output Mode) 

1 Dry Contact – NO 

2 Dry Contact – COM 

3 Dry Contact – NC 
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9.3.​ Connecting TWR-DIN with TWR-IR 

The TWR-IR is connected to the TWR-DIN via an RJ12 cable. Ensure that the RJ12 
connector is securely plugged into the communication port of both devices. 

​
Note :Check the green Power LED to confirm that the device is powered on. 
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10.​ TWS operation modes 

 

11.​ LEDs  
The LED features 3 colors: RED, BLUE, GREEN 

 

●​ Normal ●​ Alarm 

 

●​ Register Sensor / Reboot ●​ TWR-IR connection lost 
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●​ No power supply 
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12.​ Communication  
12.1.​ RS485 Modbus 

12.1.1.​ MODBUS default communication parameters 
 
Unless specified otherwise during delivery or indicated on the device, the communication 
parameters are:  

 

12.1.2.​ MODBUS table 
The MODBUS table is available at the following link: 
https://www.paralec.com/QR/TW%20-%20Modbus%20Tables%20v1.0%20(1).pdf 
 
You can also scan the QR code below for quick access. 

​
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12.2.​ Wifi  

RJ45 PIN OUT specifications : TWR-DIN & ELFIN RS485 Wifi 
 

 

  

PIN RJ45 - TWR-DINx RJ45 - Elfin RS485 to Wi-Fi 

1 A, Tx  

2 B, Rx  

3   

4  Reload 

5 VCC A+ 

6 GND B- 

7  VCC 

8  GND 

 
 

12.3.​ Cellular network 
 

Work in progress 
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13.​ Configuration   
13.1.​ User parameter​

Basic parameters that shall/can be set by user via communication (preferably 
MODBUS) are:  

Code Name Default Note 

SP01-SP07 Modbus RTU parameters See 
section 

11.1  

Communication settings must match the Modbus bus 
configuration. 

GC01 Relay Output Mode Normal 
ON 

Conditions of Relay Output activation: 
• Normal ON – relay is energized when no alarm is present 
there is no alarms​
• Normal OFF – relay is energized when an alarm is present 
• Disabled 

GC02 Relay Output Triggers All Selects which alarm types can activate the relay output. 
• All – Triggered by all alarm sources. 
• None – Relay is not triggered by any alarm. 
• Application Only – Triggered only by application alarms. 

GC03 Button Reset ON Enables manual alarm reset via the device button. 

GC04 System Alarms 
Auto-Reset 

ON Automatically clears system alarms when the alarm condition 
returns to normal. 

GC05 Application Alarms 
Auto-Reset 

OFF Automatically clears application alarms when the alarm 
condition returns to normal. 

GC06 Discard Unchanged Data OFF Prevents transmission or logging of data if no value change is 
detected. 

GC07 Duplicates Timeout 1000 ms Time window used to filter duplicate events or messages. 

GC08 Ambient Recording 
Interval 

60 Defines the sampling and recording interval for ambient 
measurements. 

GC20 Time Synch Alarm ON Generates an alarm when time synchronization fails or is lost. 

GC21 Connection Alarms ON Generates an alarm when communication or network 
connection is lost. 

GC22 Battery Alarms ON Generates an alarm when battery level is low or battery fault 
is detected. 

GC30 Enable Surface 
Temperature Alarms 

ON Enables alarms related to surface temperature thresholds. 

GC31 Enable Ambient 
Temperature Alarms 

ON Enables alarms related to ambient temperature thresholds. 

GC32 Enable Relative Humidity 
Alarms 

ON Enables alarms related to relative humidity thresholds. 

GC33 Enable Dew Point Alarms OFF Enables alarms based on calculated dew point conditions. 

GC34 Enable Surface Dew 
Alarm 

OFF Enables alarms when surface temperature approaches or 
falls below dew point. 
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13.2.​ Saving configuration and data  
See section 12.1 for the definition of parameters. 

●​ To access the configuration menu: Window -> configuration.​
 

​
 

●​ To save the configuration: click on export icon  on tool bar -> save the 
configuration file. 
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13.3.​ Upload configuration 

To upload the configuration file: click on import icon  on tool bar -> save the 
configuration file-> open 

 
 

The software has a feature to compare the parameters between the device (TWR-DIN) and 
the computer (project file) and notify users if the parameters are not matching. The 
configuration indicator will indicate in ORANGE.  

 

To apply the configuration changes: click on upload button . The configuration 
indicator will indicate GREEN. 

 
 

13.4.​ Reset and erase data  
The device comes with pre-loaded test data to allow users to verify its functionality and 
confirm it passed routine tests. This test data should be cleared before the device is installed 
to avoid confusion with actual operational data. 
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To reset the counter: Window -> Command->Execute command “EX05” (Erase Data 
Records). The device will show the attention box asking if the user still wants to continue the 
process. 

 
 

To reset the logs: Window -> Command->Execute command “EX06” (Erase System Log).              
The device will show the attention box asking if the user still wants to continue the process. 

 
 

To reset the device configuration: Window -> Command->Execute command “EX04” 
(Restore Defaults). The device will show the attention box asking if the user still wants to 
continue the process. 
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13.5.​ Reboot Device  
In case the configuration was made, after applying the new configuration to the device, the 
device needs to be rebooted to apply the configuration. OR if the user wants to manually 
reboot the device.  

 
To reboot the device: Window -> Command->Execute command “EX02” (Reboot 
Device).The device will show the attention box asking if the user still wants to continue the 
process. 
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14.​ Packaging and References  

13.1 TWR-DIN1​

           

13.2 TWR-DIN5​

      

13.3 TWR-DIN13​
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13.4 TWR-IR​

          

13.5 TWR-IR with Bracket​

       

15.​ Maintenance  
Work in progress 

16.​ Troubleshooting 
Work in progress 
 
 
 

17.​ Certification / Performance & Type Tests 
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●​ IEC 61010-2010 - Safety requirements for electrical equipment for measurement, 

control, and laboratory use 

●​ UL94-V0 - global standard for safety flammability of plastic materials used in devices 

and appliances 

●​ EN 61000-6-5:2015 - Electromagnetic compatibility (EMC) - Part 6-5: Generic 

standards - Immunity for equipment used in power station and substation 

environment 

●​ IEC 61000-6-4:2018 - Electromagnetic compatibility (EMC) - Part 6-4: Generic 

standards - Emission standard for industrial environments 

 

 

18.​ Contact 
Our email :  
info@paralec.com 
 
Our EUROPE office : 
PARALEC Energy SAS 
Le Mathis, 204 av de Colmar 
67100 Strasbourg - FRANCE 
 
Our ASIA office:  
PARALEC Energy Co Ltd 
Liberty Plaza, 20th Floor, 
1000/5-6, Soi.Thonglor, Sukhumvit 55 Rd., 
Klongton Nua, Wattana, 
10110 Bangkok – THAILAND 
 
Our website : 
www.paralec.com 
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